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1. Définition 

Excel est un logiciel de la suite bureautique Microsoft-
Office, appelé tableur, permettant la création, la 
manipulation et l’édition des données qui sont 
organisées sous forme de tableaux. 

13/11/2019 http://benabdellah-informatique.wifeo.com 



2. Fonctions de base 

 Structure d’un classeur Excel 
 Options d’affichage des données 
 Insertions et suppressions 
Mise en formes des données 
 Calculs : exécution, fonctions, etc. 
 Création des graphiques 
 Impression 



 Description générale 
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Barre de Titre 
Barre des Menus 

Barre d’outils 
« Standard » 

Barre de formules 

Ligne 

Colonne 

Cellule 
Feuille de calcul 



Notion de classeur 

Microsoft Excel produit des classeurs (des fichiers tel 
que leur extension est (.xls) ou (.xlsx)) sur lesquels vous 
travaillez et vous stockez les données. 

Chaque classeur peut contenir de nombreuses feuilles. 

Vous pouvez organiser différentes sortes d'informations 
au sein d'un même Fichier Excel. 
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Notion de feuille de calcul 

Les feuilles de calcul du classeur servent à répertorier 
et analyser des données. 

Vous pouvez renseigner ou modifier des données 
dans plusieurs feuilles de calcul et effectuer des 
calculs à partir de données provenant de plusieurs 
feuilles. 

Vous pouvez placer un graphique sur la même feuille 
de calcul que les données qui s'y rapportent ou sur 
une feuille distincte. 
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Click droit sur l’onglet de 

la feuille concernée 



Structure de données sous Excel (i) 
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 Une base de données excel est composée 
d'enregistrements. Chaque enregistrement est subdivisé 
en champs (Attributs). 

 Dans Excel, les enregistrements se présentent en lignes 
et les champs en colonnes. 
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Structure de données sous Excel (ii) 
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 Les champs d’une base de données se distinguent par leurs 
noms. 

 Le nombre maximum des champs et/ou d'enregistrements 
dépendent respectivement du nombre de colonnes et du 
nombre de lignes de la feuille et de l'espace mémoire 
disponible. 

 Au sein d'un même classeur, plusieurs feuilles peuvent 
contenir des données. On parle alors des tables. La base de 
données étant représentée par le classeur. 
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 Options d’affichage 

 Sous Excel, vous pouvez ajuster la largeur des lignes et 

des colonnes pour afficher le contenu des cellules.  

 Placez le curseur de la souris entre deux boutons de colonnes et/ou de lignes 
jusqu'à voir apparaître les flèches de redimensionnement, enfoncez le 
bouton gauche et glissez jusqu’au appariation du contenu. 
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 Pour afficher le texte en gardant la taille de la cellule: Sélectionnez la 
cellule puis cliquez sur bouton droit → Format de cellule → Alignement 
→ Ajuster. 
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Masquage et Affichage  
Certaines lignes et colonnes, ne servent qu’à la mise en œuvre 
de calculs intermédiaires du tableau. Leur affichage n’étant 
pas indispensable, il est possible  de cacher ces lignes et 
colonnes en cliquant sur bouton droit puis sur Masquer.  

Vous pouvez les afficher, par la suite, en sélectionnant les 
deux cotés (Lignes ou colonnes) et en cliquant sur bouton 
droit puis sur Afficher. 
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  Insertion et suppression 
 Vous pouvez gérer l’insertion et la suppression de lignes, de 

colonnes et de cellules : 

  Insertion: Vous sélectionnez toujours la cellule, la ligne ou la 
colonne qui vient par la suite, cliquez sur bouton droit puis sur 
insertion. 

  Suppression : Sélectionnez la cellule, la ligne ou la colonne, 
cliquez sur bouton droit puis sur supprimer.  
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Format de cellule (i) 
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En sélectionnant une cellule ou un ensemble de cellules et en 
cliquant sur bouton droit vous aurez une liste déroulante, la boite 
de dialogue affichée en bas s’affiche si nous choisissons Format de 
cellule:    



Format de cellule (ii) 
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Faire des commentaires 

 Avec la barre d'outils Révision, vous pouvez 
insérer des commentaires aux cellules. Si un 
commentaire existe déjà pour une cellule,  vous 
pouvez effectuer des modifications. 

Affichage → Barres d'outils  →  Révision 

 Pour afficher les commentaires, 
sélectionner Affichage → Commentaires  
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Mise en forme rapide avec des styles 
ou des formats prédéfinis 
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Excel propose des styles pour mettre en forme des 
nombres en tant que monnaie, pourcentage ou à l'aide de 
la virgule comme séparateur des milliers : Format → style 

Pour mettre en forme une liste entière vous pouvez lui 
appliquer un modèle de tableau prédéfini : Format → Mise 
en forme automatique  

 



Format conditionnel 
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 Pour une même cellule ou un ensemble de cellules, 
plusieurs formats d'affichage sont possibles en 
fonction des valeurs contenues. 

Format → Mise en forme conditionnelle 



Modèle de classeur 

 Certaines feuilles ou classeurs sont utilisés 
comme base de calcul avec des données 
différentes. Leur structure peut être sauvegardée 
comme modèle (.xlt ou .xltx). Les formules de 
calcul, les graphiques et les rapports font partie 
intégrante du modèle.  
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Opérations arithmétiques  
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 Pour effectuer des opérations arithmétiques simples ou 

calculer des expressions mathématiques, sur une cellule,  
dans une feuille de calcul Excel, utiliser le champ "=" de la 
barre de Formules. 

 Vous pouvez utiliser ce champ avec des références à des 
cellules. 
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Opérateurs de calcul (i) 
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 Opérateurs arithmétiques: Pour effectuer les opérations 
mathématiques de base telles que l'addition, la 
soustraction ou la multiplication. 

 Opérateurs de comparaison: Pour comparer deux valeurs. 
Le résultat obtenu est une valeur logique VRAI ou FAUX. 

 



Opérateurs de calcul (ii) 
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 Opérateur de concaténation de texte: Utilisez le signe 
« & » (et commercial) pour combiner (concaténer) une ou 
plusieurs chaînes de texte en vue d'obtenir un seul 
élément de texte. 

 Opérateurs de référence: Combinez les plages de cellules 
pour effectuer des calculs. 

 



Exécution d’un calcul (i) 
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 Cliquez sur la cellule dans laquelle vous souhaitez voir 
apparaître le résultat. 
 Dans la barre de formule cliquez sur fx. Cette barre 
permet de saisir ou de modifier les valeurs ou les formules 
des cellules.  
 Pour faire référence au contenu d'une cellule, cliquez sur 
la cellule correspondante ou saisissez les références de la 
cellule.  
Exemple: Recettes Tarif plein = Tarif plein * Nb Entrées au 
Tarif plein 



Exécution d’un calcul (ii) 
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 Pour répéter une formule dans plusieurs cellules adjacentes, 

cliquez sur la partie inférieure droite de la cellule contenant 
la formule et faites glisser le curseur :  

 

 

 

 

  

 

NOTE :  Excel recalcule automatiquement les formules en 
utilisant les valeurs des cellules qui ont été modifiées. 
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Références relatives et références 
absolues 
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 Dans les formules de calculs, l'adaptation des coordonnées 

des cellules en fonction de leur position relative est 
automatique. 
 La mise en absolu de la référence d'une cellule au sein 
d'une formule de calcul s'effectue via le caractère $. 
 Le symbole $ bloque la référence de la cellule concernée 
dans la formule. 



Cellule nommée 
 Excel autorise la création d'étiquettes pour une cellule 

ou un groupe de cellules. Les étiquettes utilisent des 
références absolues par défaut.  

 Par exemple, on peut définir l'étiquette TVA pour la 
cellule H106 :  

 On sélectionne la cellule H106 puis pour la renommer  
on passe au menu Insertion comme suit : 

 Insertion → Nom → définir 
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Utilisation de fonctions 

 Excel propose différentes catégories de fonctions pour 
satisfaire un large panel d'utilisateurs : 

Insertion → fonction 
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Traquer les erreurs (i) 

 Utilisez  la barre d'outils Audit pour traquer les 
erreurs de vos calculs : 

 

 Cliquez sur l'icône Repérer une erreur. 

 - Toutes les cellules impliquées dans le processus 
sont marquées en rouge. 

 - Les cellules susceptibles d'être à l'origine de 
l'erreur sont marquées en bleu .  
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Traquer les erreurs (ii) 
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Création des graphiques (étape 1) 
Sur la barre de menu, sélectionnez Insertion → Graphique. Excel ouvre 
l'assistant graphique.  

 Cet outil guide l'utilisateur selon 4 étapes pour réaliser des 
graphiques. 
 Les éléments sélectionnés au sein de cet assistant ne sont pas 
définitifs. Par la suite, toutes les modifications utiles et nécessaires au 
parachèvement de l'ensemble peuvent être apportées. 

 

Assistant graphique, 1ière étape, 
- Type de graphique - 

 
Excel propose de nombreux types de graphiques 

standards et personnalisés. 



Création des graphiques (étape 2) 
Cette étape propose de définir la zone de données source du graphique.  

 Si la sélection d'une zone source est réalisée à priori, ses coordonnées 
apparaissent dans la Plage de données. Le nom de la feuille et les 
paramètres de la zone sont repris. 
 La lecture de cette zone s'effectue soit horizontalement (Lignes), soit 
verticalement (Colonnes). Les 2 lectures produisent des graphiques 
différents. 

 

 

Assistant graphique, 2ème  étape , 
- Données source du graphique - 



Création des graphiques (étape 3) 
4 titres sont accessibles selon le type de graphique sélectionné :  

 Le titre général du graphique, le titre de l'axe des X, le titre de 
l'axe des Y et le titre de l'axe des Z.  
 Pour Excel, l'axe des Y se situe à droite du graphique. L'axe des Z se 
situe à gauche ou dans la profondeur pour une représentation 
tridimensionnelle. 

Assistant graphique, 3ème étape, 
- Options du graphique, Titres - 



Création des graphiques (étape 4) 

Assistant graphique, étape 4  
- Localisation du graphique - 

Le graphique est créé soit sur une nouvelle feuille, soit comme objet 
au sein de la feuille courante. 
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Personnaliser un graphique 

En plus du graphique, Excel affiche une barre d'outils Graphique 
spécifique. 

Pour chaque élément sélectionné,  vous pouvez définir plusieurs 
paramètres spécifiques, par exemple : 



Types de graphiques (1) 

Anneau 



Types de graphiques (2) 

     

 

 

Bulle 



Types de graphiques (3) 

     

 

 

 Secteurs 



Types de graphiques (4) 

     

 

 

 Courbes 



Imprimer les tableaux 

L'impression d'un tableau s'effectue en cliquant sur Imprimer. 

Cependant, pour s'assurer de la bonne réalisation de cette opération, il 
s'avère utile d'effectuer préalablement un aperçu avant impression : 
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3. Analyse des données 

Classement 

Filtres automatiques 

Filtres élaborés 

Sous-totaux et Plan automatique 

Tableaux croisés dynamiques 



  

Classement (ordre de tri) 

   

13/11/2019 

Positionnez le curseur dans la liste. Dans la barre de menus, 
sélectionnez Données – Trier: 
 Le classement s'effectue sur tous les champs et tous les 
enregistrements du tableau. 
 Le classement s'effectue d'abord sur la première clé. S'il 

s'avère impossible de réaliser une distinction entre les éléments 
de cette première clé, la deuxième clé est consultée. La troisième 
clé est utilisée si aucune distinction n'est possible entre les 
enregistrements sur les deux premières clés.  

Vous pouvez également créer l’ordre de tri personnalisé : 
Outils → Options → Listes personnalisées 



  

Filtres automatiques 
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Positionnez le curseur dans la liste. Dans la barre de menus, sélectionnez 
Données → Filtre → Filtre automatique : 
 Les opérations de filtrage permettent de retrouver un sous-
ensemble de données contenant une certaine valeur ou répondant à 
des critères de sélection. Un filtre ne réorganise pas les données du 
tableau. Il permet de visualiser les données que l’on souhaite filtrer 
et de masquer le reste du tableau. 
 Vous pouvez appliquer au maximum deux conditions à une 
colonne à l'aide de la commande Filtre automatique. 

 



Filtres élaborés : zone de critères 
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Vous devez utiliser des filtres élaborés: Données → Filtre → Filtre élaboré: 
 Si vous cherchez à appliquer trois conditions ou plus à une colonne, 
 Si vous voulez utiliser des valeurs calculées comme critères,  
 Si vous voulez copier des enregistrements vers un autre 
emplacement. 

Plusieurs critères placés sur une même ligne utilisent l'opérateur 
relationnel ET. Des critères placés sur des lignes différentes utilisent 
l'opérateur relationnel OU. 

Visualise tous les enregistrements relatifs au client Nelson  
 (quels que soient la spécification et la quantité), 

Tous les enregistrements relatifs au client Page, 
mais uniquement pour ses commandes de ProdX 
(sans quantité), 

Tous les enregistrements de Prod A (quel que soit le client) 
et dont la quantité est supérieure ou égale à 20. 

Visualise tous les enregistrements relatifs à la spécification Prod X 
ou Produit A 

Visualise tous les enregistrements relatifs au Client Nelson ou Page 



Filtres élaborés : exécution 
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Le curseur se trouvant au sein de la base de données, dans la barre 
de menu, sélectionnez Données → Filtre → Filtre élaboré. 
 L'action Filtrer la liste sur place affiche la sélection  
à l'emplacement de la base de données. 
 L'action Copier vers un autre emplacement duplique les 
enregistrements sélectionnés dans une autre zone. 
 Par défaut, la base de données est sélectionnée (Plages). 
La Zone de critères et la Zone de Destination doivent être 
spécifiées par l'utilisateur. 



Sous-totaux et plan automatique (i) 
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L’outil Données → Sous-totaux permet de réaliser une analyse plus 
détaillée du contenu d'un tableau. 
 A chaque changement de Titre du film utilisez la fonction 
Somme. Ajoutez un sous-total aux Entrées  

Effectue un saut de page entre 
chaque groupe de données pour 
une base de données faisant 
plusieurs pages. 



Sous-totaux et plan automatique (ii) 
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Sous-totaux et plan automatique (iii) 
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 Sur le côté gauche de l'écran, une colonne reprenant les icônes 
1 2 3 est ajoutée. Ces icônes permettent de réaliser plusieurs 
vues du résultat. 

 Par défaut, Excel affiche le résultat en mode 3. Un clic sur 
l'icône 2 donne une vue réduite aux seuls totaux. 
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Un tableau croisé dynamique est un tableau interactif qui permet 

d'effectuer une synthèse rapide et de croiser de grandes quantités 

de données.  

Vous pouvez faire pivoter ses lignes et ses colonnes pour: 

 Obtenir différentes synthèses des données sources,  

 Filtrer les données en affichant différentes pages, 

 Ou afficher les détails pour les zones qui vous intéressent :  

 Données → tableaux croisés dynamiques 

Tableaux croisés dynamiques (i) 



Tableaux croisés dynamiques (ii) 



  

Utilisation de l’aide 

   

13/11/2019 



Pour en savoir plus sur 
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 http://benabdellah-informatique.wifeo.com 

 http://www.sc.ucl.ac.be/training/indextraining.html 

 http://www.tutorials-online.com/tutorials/cursus/demo/xl97/chap1/main.htm 

 http://www.cma.cuslm.ca/estouest/office97.fr/commence.html 

 http://www.poitou-charentes.iufm.fr/tice/ressources/tutoriels.html 

 http://csrs.qc.ca/goeland/proj/envolee/sacdestic/formations.html 

 http://www.cavi.univ-paris3.fr/ilpga/ilpga/tal/cours/tdMZ-00-01/index.htm 

Je vous souhaite bon courage 


